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Chapter

Introduction

Welcome to Hypercosm Teleporter for 3ds Max™, one of the most
powerful and reliable means of posting your 3D content to the web.
Hypercosm makes it easy to share your 3ds Max™ scenes with oth-
ers and to create dynamic interactive 3D web content.

Hypercosm Teleporter Benefits

The Hypercosm system allows you to publish 3D content just like
you publish other rich media content such as video and sound. With
Hypercosm, you can turn your 3D models into a rich communica-



tions medium, opening up the benefits of 3D graphics to a wide
audience.

Sharing

The Hypercosm system lets you share 3D models with anyone
regardless of whether they have 3ds Max™ or not. All they need to
do to view Hypercosm models is to install the free Hypercosm
Player. This lets you share your 3D concepts with customers, col-
leagues, family and friends.

Low File Sizes

Hypercosm's patented unique approach to encoding object geome-
try and behavior results in very low file sizes that can be delivered
over the web in a practical and effective manner.

Encryption

Hypercosm Teleporter translates your 3ds Max™ models into a
compressed and encrypted form that is practical and safe for you to
post on a web site. Once they have been converted into Hypercosm
format, your 3D scenes can not be edited in any way so your original
models remain safe.

Ease of Use

Hypercosm Teleporter has an easy to use interface for quickly con-
verting your 3ds Max™ scenes into web deployable content. Once
you've finished the installation process, with just a few mouse clicks
you can translate your 3ds Max™ scenes into web pages that can be
posted on the Internet.

10



Interactivity

A 3D engine inside of the Hypercosm Player delivers realistic inter-
active graphics with textures and lighting supported by the 3D
capabilities of your video card. Rather than just viewing a static
image, viewers can navigate through the 3D scene interactively and
gain a much better understanding of the 3D models than is possible
with any other technique.

Integration

Hypercosm Teleporter lets you integrate Hypercosm 3D content
into web pages, and even PowerPoint documents.

Hypercosm System Overview

Hypercosm 3D content is a powerful, web based medium for inter-
active, online communication of 3D visual information with online
customers, clients, coworkers, collaborators, or students. The trans-
mission of Hypercosm 3D content is made possible by a system of
software products. The process of creating, posting, and viewing
Hypercosm 3D content is depicted below:
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Hypercosm Software Components

There are two essential families of software components in the
Hypercosm system. The first is Hypercosm viewing software which
is used to display content that is in Hypercosm format. The second
family of software is Hypercosm development software which is
used to create content in the Hypercosm format.

Hypercosm Viewing Software

e Hypercosm Player

To view Hypercosm content on the Web, online users first need
the Hypercosm 3D Player, a web browser plug-in that runs

12



Hypercosm applets. The Hypercosm 3D Player integrates with
the web browser in a similar fashion to other plug-in based
media-enabling player technologies. All of these technologies
require that end users download and install a player to use the
particular media type that they enable. The Hypercosm Player
software is freely downloadable from the Hypercosm web site (
www.hypercosm.com ).

Hypercosm Development Software

Hypercosm Teleporter

The first and most important part of the Hypercosm develop-
ment software system is Hypercosm Teleporter. Hypercosm
Teleporter translates 3D model and animation information
from an existing 3D authoring tool such as Discreet's 3ds Max™
and transforms it into a web deployable Hypercosm 3D applet
that can be viewed using the Hypercosm Player.

Hypercosm Studio

Hypercosm Studio is a scripting tool used by expert Hyper-
cosm developers. Using Hypercosm Studio, you can program
directly in Hypercosm’s object oriented OMAR (Object Ori-
ented Modeling, Animation, and Rendering) language for
maximum power and control. Hypercosm studio lets you pro-
gram arbitrary behavior, interactivity, and even physics. For
more information on Hypercosm Studio, contact Hypercosm.

13






Chapter

Getting Started

To get started using Hypercosm Teleporter for 3ds Max™, you must
first install Hypercosm Teleporter onto a computer that already has
3ds Max™ installed. Once complete, you can run Hypercosm Tele-

porter by first starting up 3ds Max™ and then running Hypercosm
Teleporter from the File>Export menu inside of 3ds Max™.

Installing Hypercosm Teleporter

The following steps show you how to how install Hypercosm Tele-
porter. Once the Hypercosm Teleporter has been installed, you can
run it from inside of 3ds Max™.

15



e Step 1: Run the Installation Program
To install Hypercosm Teleporter, run the Hypercosm Teleporter
installer. This installer software can be found on the CD-ROM
for the product version of Hypercosm Teleporter and can be
downloaded from the web for the evaluation version. When the
installer starts up, you should see the interface shown below. To
proceed, click the “Install” button at the bottom.

i'é‘- Hypercosm Teleporter InstallShield Wizard x|

H ype rcCoOsm Welcome to the InstallShield Wizard for
Hypercosm Teleporter

The InstallshieldiR) Wizard will install Hypercosm Teleporter
on your computer, To continue, click Next,

WARNING: This program is protected by copyright law and
international treaties,

www.hypercosm.com

Cancel

= Back
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Step 2: Accept the License Agreement

To proceed, you will need to accept the license agreement by
clicking the top radio button in the interface shown below.
Once this is done, click the “Next” button at the bottom.

i'é‘- Hypercosm Teleporter InstallShield Wizard x|

License Agreement
Please read the following license agreement carefully,

License For Customer Use of Hypercoswm Teleporter ﬂ
Software
INPORTANT MNOTICE -- READ CAREFULLY: This LICENSE is the

agreement which governs use of the Hypercoswm Teleporter
software, including computer software and associated
printed materials ("IC0FTWARE™). By installing, copying,

or otherwise using the SOFTWARE, vou agree to be bhound

by the terms of this LICEN3IE. If you do not agree to the
terms of this LICEN3IE, do not install the S0FTWARE. :J

& T accept the kerms in the license agreement Print |

" 1 dn not accept the terms in the license agreement

Installshield

< Back I Mext = I Cancel |
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Step 3: Select the Destination Folder

The next step is to select the destination folder for the Hyper-
cosm Teleporter software. Although you can install the soft-
ware to any location on your hard drive, we suggest that you
keep the default location (C:\Program Files\ Hyper-
cosm \ Hypercosm Teleporter for 3ds Max\). To proceed, click
the “Next” button at the bottom.

i'é‘- Hypercosm Teleporter InstallShield Wizard x|

Destination Folder
Click Mext to install to this Folder, or click Change to install to a different Folder,

G Install Hypercosm Teleporter to:
C:\Program Files\HypercosmiHypercosm Teleporter) change... |

Installshield

Cancel

< Back




Running Hypercosm Teleporter

To run Hypercosm Teleporter, start up 3ds Max™ and perform the
steps described below.

e Step 1:In 3ds Max™, select “Export...” from the

“File” menu
In 3ds Max™, click the File menu on the main menu bar and
select the Export menu option as shown below.

File Edit Tools Group Wiews Create Modifiers Character Animation  Graph Editors

Mew. .. Chrl+M

Reset 3

iR o ] Compounds ] Lights & Eameras] Particles ]
Save Chrl+5

Save As...

Save Selected

¥Ref Objects...
#Ref Scene. ..

Merge. ..
Merge Animation. ..
Replace. ..

Archive. .,
Summary Infa...
File Properties. ..

‘Wiews Image File. ..

Exit
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Step 2: Type in a name for the exported scene

By selecting Export from the File menu, a file dialog box will be
displayed. In the first text box at the bottom of the dialog, type
in a name for the exported scene. This name will be used as the
name of a new folder which will contain the web page, the
exported Hypercosm applet, and any other resources needed
for the web deployable applet (such as sounds, textures, etc).

Select File to Export ﬂll

Save in: I m Desklop j

r-A My Documents
- My Computer
5E My Metwork Places

File name: ( - |’ Save |

Save as ype: IHypercosm Teleporter [*.] 'l Cancel

v
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e Step 3: Select the “Hypercosm Teleporter”
exporter
Select the Hypercosm Teleporter exporter from a list of avail-
able exporters. This is done using the selection box labeled
"Save as type" which is located at the bottom of the dialog box.

Save in: I m Desklop j

Vé‘ My Documents
- My Computer
5E My Metwork Places

op

ey

My Documents

File name: I j Save
Save as type: {l Hypercosm Teleporter [%.) " Cancel |

7
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Step 4: Press “Save”

After you have selected a file name and type, press the “Save”
button at the lower right corner of the dialog box.

Vé‘ My Documents

= My Computer
v Metwork Places

File name: I j
Save as ype: IHypercosm Teleporter [*.] j Cancel

v
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Step 5: Press “Export”

After saving the file, the Hypercosm file export dialog box will
be displayed. In order to export the scene, press the "Export"
button at the bottom of the dialog box. If the "View After
Export" checkbox on the left side of the dialog is checked, then
the Hypercosm Teleporter will automatically bring up your
web browser after it has finished exporting the scene to show
you the final exported scene inside of the web browser.

Hypercosm Teleporter il

Express | Interface | ‘web | Testures | Animation | Advanced | Script | About |

Hypercosm

Teleporter

Exporter for 3ds Max™

Copyright 2006 Hypereosm LLC. Wiww. hypercosm.com

Active Camera: ypercosm Default Cameral

v iew After Export

Defaults Preview Cancel
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Hypercosm Applets

When you export files out of 3ds Max™ using Hypercosm Tele-
porter, you will be creating a new type of file that is known as a
“Hypercosm applet”. An “applet” is a small program that runs
using the assistance of another program, in this case the Hypercosm
Player. Hypercosm applets are actually little programs to generate
and display the 3D graphics depicted in your 3ds Max™ scene. For
those of you who are familiar with programming, the term “applet”
usually refers to a Java applet. Hypercosm applets are conceptually
very similar to Java applets except instead of using the Java Virtual
Machine, they use the Hypercosm Virtual Machine which has spe-
cial extensions for 3D graphics. For this reason, the applet files will
be named using the “.hcvm” file extension which stands for
“Hypercosm Virtual Machine”.

Viewing Hypercosm Applets

When you export a 3ds Max™ scene using Hypercosm Teleporter,
it will create a Hypercosm Applet. Hypercosm applets are viewed
using the Hypercosm Player.

The Hypercosm Player

The Hypercosm Player is automatically installed for you when you
install Hypercosm Teleporter. The Hypercosm Player can be started
up easily to view an applet in a variety of ways.

e Using Hypercosm Teleporter
If you have the “View After Export” option on the Express tab
selected, then your web browser will automatically be started
up whenever you export a scene to show you a web page con-
taining your newly exported Hypercosm applet.

24



e Using Your Web Browser
The Hypercosm Player can be run just by starting up a web
browser on any page containing a Hypercosm applet. The web
browser will automatically start up the Hypercosm Player and
display the running applet inside of the web page.

e Using Windows
You can start up the Hypercosm Player directly just by double-
clicking on any Hypercosm applet ((hcvm) file. This will start
up a Hypercosm applet and will display the graphical simula-
tion inside of a new window.

The Standard Applet User Interface

The Hypercosm Player is unlike many other 3D media players
because the interface is part of the content rather than built-in to the
player. This means that Hypercosm applets can each have their own
custom user interfaces. Even though it's possible to create custom
interfaces, most Hypercosm applets will tend to use a standard
interface that is defined by the support files that are used when that
applet is compiled. This section of the documentation describes that
standard user interface.

25



Title
Sub Title {with Bubbles!)

Docking
Bar

User Interface Components

The standard user interface allows the user to navigate around the
3D scene, to set the number of mouse buttons to use, to collaborate
with other users across the network, and to control the graphics set-
tings which determine how the 3D scene is drawn. The standard
user interface contains the following components:

o Title
The title is used to display the name or other descriptive phrase
about the applet.

* Subtitle
The subtitle is used to display an additional optional descriptive
phrase about the applet.

e Mouse Controls

26



The mouse controls are the main way that the user interacts with the
applet. These controls are used to navigate around the three dimen-
sional scene by clicking and dragging on the main display window
of the applet. The mouse controls can alter the scene's rotation, the
viewer's direction of view, and the location of the viewer in the
scene.

e Docking Bar

The applet docking bar is displayed at the bottom of the running
applet and is the place where the applet controls are kept. These
controls allow the viewer to configure the mouse controls, to change
the graphics display methods, and to collaborate with other users
across the Internet.

Standard Two Button Mouse Controls

The standard mouse controls are used mainly to navigate around a
three-dimensional scene. These standard mouse controls assume
that you are using a two button mouse. The standard mouse con-
trols allow you to spin, pan, and zoom.

e Spin

1

v

To make the scene rotate or spin, position your mouse pointer over

the scene, click and hold the left mouse button, and drag the pointer
horizontally or vertically in the direction you want the scene to spin.
Note how the scene spins horizontally or vertically in the direction

that you drag the pointer.
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e Pan

s |

To change your direction of view, position your mouse pointer
somewhere within the frame, click and hold the right mouse button
and drag the pointer. You'll see your direction of view change to fol-
low your mouse pointer.

e /oom
If

»

To zoom in or out of the scene, position your mouse pointer over a
point in the scene that you want to move towards or away. Next,
click and hold both mouse buttons while you drag the pointer
towards you (downward) to bring the scene closer or away from
you (upward) to push the scene away. Note that the zoom control
actually moves your viewing position rather than just changing
your field of view so you can use this zoom control to "zoom
around" the scene. By combining the zoom control and the pan con-
trol, you can easily drag your viewpoint along an arbitrary path
through the three dimensional scene.
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The Applet Docking Bar

The applet docking bar is displayed at the bottom of the running
applet and is the place where the applet controls are kept. Below is a
close-up view of the docking bar.

Mouze Graphice  Collaborate

Standard Controls

Hypercosm applets using the standard docking bar may contain
any of the icons shown above. Applets may be also be configured to
omit or add any of these controls, but most standard applets will
contain this full set of controls.

e About Icon

il

This icon can be clicked to cause the web browser to bring up the
Hypercosm web page. The Hypercosm web page is a source of
information about the various software tools that are available to
create and display Hypercosm content and it also provides useful
support and troubleshooting information.

e Hide Icon
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This icon toggles the dock's auto-hiding feature. When enabled,
auto-hiding will cause the dock to disappear when the user moves
the cursor away from the dock. When the user moves the cursor
back to the location of the dock, the dock will reappear once again. If
the auto-hiding feature is not selected, then the dock will always be
displayed.

e Mouse Icon

-

This icon can be clicked to display a set of controls for setting the
number of mouse buttons to use. Normally, the controls are config-
ured to use a 2 button mouse. If the user wants a one button inter-

face, then this control allows the applet to be configured to use just a
single mouse button.

e Graphics Icon
This icon can be clicked to bring up a set of controls for configuring

the way the 3D graphics are drawn.

e Collaboration Icon

Collabaorate

This icon can be clicked to display the collaboration controls. The
collaboration controls can be used to configure an applet to run in
synchronization with another applet running on another machine
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on the network. Hypercosm collaboration allows peer-to-peer col-
laboration (one person to one other person) across a non-secure net-
work (without firewalls). The other user may be located across the
hall or across the world. If an IP address for the other user is pro-
vided in the web page, then the applet will connect with that user.
Otherwise, the applet will try to connect with another user on the
same subnet. The collaboration controls allow the two users to
switch off being the "leader" and the "follower". When the user is
playing the "leader"”, then they control the view point for themselves
and for the other user. When the user is playing the "follower", then
they see scene from the point of view of the leader and have no con-
trol over the view point.

e HelpIcon

- .
-

a2

This icon can be clicked to bring up information about how to use
the Hypercosm applet and the various applet controls.

Sharing Hypercosm Applets

One of the great things about exporting 3ds models using Hyper-
cosm Teleporter is that Hypercosm makes it easy to share your mod-
els with colleagues and friends. These people will not be able to
interactively view your 3ds models if they don't have 3ds Max™
installed on a machine. However, if they have the Hypercosm
Player installed, then they can view Hypercosm applets that are cre-
ated from 3ds models. They will not be able to edit the 3ds scenes,
but they will be able to view them and navigate through them.
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Downloading Hypercosm Player

The Hypercosm Player can be downloaded and installed easily from
the Hypercosm web site ( http://www.hypercosm.com ). To down-
load and install the Hypercosm Player, just go to www.hyper-
cosm.com/download and follow the instructions.

Posting Hypercosm Applets on a Web Page

One of the convenient ways of sharing Hypercosm applets is by
posting them on a web site. You can post Hypercosm enabled web
pages the same way that you post regular web pages. Just copy the
directory containing the HTML file that is exported from the
Hypercosm Teleporter into your web site directory and link to it
from your web site. Once you upload your web pages, your 3D
model will be online. No special server software or other configura-
tion is necessary. If anyone wants to view your 3D models, they just
need to install the Hypercosm Player and then visit your web site.

Emailing Hypercosm Applets

Another convenient way to share Hypercosm applets is by using
email. You can email Hypercosm applets just by adding them to
your email as email “file attachments”. One convenient way of
emailing web pages and other collections of files is by using a utility
such as “Winzip” to group a collection of files into a single file.
Once you've emailed your Hypercosm applets, the person receiv-
ing the email will have to make sure that they have the Hypercosm
Player installed. Once this is done, they will just have to save and
unzip the file attachment and then double-click on either the HTML
file in the directory or the Hypercosm applet (HCVM) file.
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Chapter

Using Hypercosm
Teleporter

Although Hypercosm Teleporter allows you to very easily export
files, it also has advanced features that allow you to customize the
export process. This section describes Hypercosm Teleporter’s
advanced features and how you can use these advanced features to
optimize the export process for best results.
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In the previous section, you saw that the Hypercosm Teleporter
interface has a series of tabs at the top of the dialog box. These tabs
allow you access Hypercosm Teleporter's advanced features and

capabilities.

Hypercosm Teleporter % il
@erface | Wweb | Tewtures | Animation | Advanced | Script | Aboul

~

4 Hypercosm
~ Teleporter

Exporter for 3ds Max™

Copyright 2006 Hypereosm LLC. Wiww. hypercosm.com

Active Camera:

v iew After Export

Defaults | Freview | Export | Cancel |

The following pages describe the functions that are available under
each of the tabs shown at the top of the Teleporter dialog box shown

above.
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The "Express" Tab

Pressing the "Express” tab will display the interface shown below:

x
Interface | ‘web | Testures | Animation | Advanced | Script | About |

Hypercosm

Teleporter

Exporter for 3ds Max™

Copyright 2006 Hypereosm LLC. Wiww. hypercosm.com

Active Camera: ypercosm Default Cameral

v iew After Export

Defaults | Freview | Export | Cancel |

This interface presents only the most basic and essential options to
the user for quick export. The options presented on this tab are:

Active Camera

The active camera is the initial camera that will be used in the
exported scene. If you have no cameras defined in the 3ds Max™
scene, then an appropriate camera will be chosen for you automati-
cally. This automatic camera is listed in the drop down menu as
"Hypercosm Default Camera". If you have defined a set of cameras
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in the 3ds Max™ scene, then these cameras will also appear by their
names in the list. If you have selected a viewport for a camera view
in 3ds Max™, then that camera will appear in the Teleporter dialog
as the default camera selected. If you have selected a view in 3ds
Max™ with no associated camera (such as top view, bottom view,
left view, right view, etc.), then the Hypercosm Default Camera will
be selected as the default camera.

View After Export

The "View After Export" option causes the Hypercosm Teleporter to
automatically open up a web browser to view your scene inside of a
web page immediately after it has been exported. If this tab is not
checked, then the Hypercosm Teleporter will still export your 3ds
MaxTM scene, but it will not automatically show you the final
exported scene. If you want to view the exported scene, you can at
any time use Windows to open up the folder containing the
exported scene and double click on either the web page in that
folder (.html) or the Hypercosm applet file within that folder
(-hcvm). Either of these two actions will launch the Hypercosm
Player to allow you to view the exported Hypercosm applet. If you
double click on the web browser, then the applet will play inside of
a web page. If you double click on the applet file, then the Hyper-
cosm Player will open a window to show the applet.
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The "Interface" Tab

Pressing the "Interface" tab will display the interface shown below:

Hypercosm Teleporter il

Express ‘Web | Tewtures | Animation | Advanced | Script | About |

r Select Interface

& Default
£ Custam I Browse
r Previe

Defaults | Freview | Export | Cancel |

This interface is used to configure the user interface that is pre-
sented by the exported Hypercosm applet. Hypercosm Teleporter
Pro allows you a great deal of flexibility in terms of being able to
configure the user interface used in your exported applets. This
allows you to control the way that the model is presented in order to
match the needs of your users and to best suit the model.
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Select Interface

The Interface tab allows you to choose from two types of user inter-
face: the “Default” user interface, where the interface is compiled
into the applet or a “Custom” user interface, where the user inter-
face is defined by the HTML and Javascript of a user interface skin.

Preview

The preview pane displays what the currently selected skin will
look like when exported. If you change the background color or
select a background image using the options in the “Web” tab, then
these selections will also be reflected in the preview.

The Skin Browser

If you select “Custom” underneath the “Select Interface” option
above, then a “skin browser” will open up which you can use to
select a particular user interface skin. The skin browser is a dialog
box which allows you to navigate to a particular skin and also dis-
plays a preview image of the skin that is currently selected. The skin
browser dialog box looks like the user interface shown below:
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Look jn: IE} Standard Skins j " &5 Ef-

=) Standard with Large Buttons
=) Standard with Small Buttons
=) Standard with Small Buttons and Maps

File name: Iupport Filez\Skins\Standard SkinghMouse Dnlyj Select
Files of bype: IHypercosm Teleparter Skin Folder j Wig
Lancel

Preview:

Example Skins
Below are a set of example skins that show how the functionality
and the aesthetics of the user interface can be changed using differ-

ent skins:
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The “Standard with Large Buttons” Skin
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The “Mouse Only” Skin

The “Turbo Squid with Large Buttons” Skin
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The "Web" Tab

Pressing the "Web" tab will display the interface shown below:

x
Express | Interface Textures | Arimation | Advanced | Script | About |

r— Optio:

[~ Compile all resources inta applet

r— Background Option:

& Default £ Custam colar |
¢ Custom image Browse

r Internet Explorer

[~ Inzert the mark of the wek for viewing on local machine

Defaults | Freview | Export | Cancel

The "Web" dialog box is used to control how the 3D scene is
exported to a web page. This dialog box has three main sections:

Options

The "Options" section includes the following option:

e Compile all resources into applet
This option allows you to choose to either compile a 3D scene
into a single large file or into a collection of smaller files which
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can be individually edited and maintained. A complete Hyper-
cosm applet can contain a variety of different parts. First, it con-
tains the definition of the 3D geometry, materials, and
animation. Second, it can also contain a collection of
"resources". Resources are units of data that are defined in their
own file format and are often represented as separate files. The
most common examples of resources are texture images (JPEG,
GIF, or PNG files), and sounds (.WAV or .MP3 files).

The advantages of compiling a scene into a single file are (1)
simplicity and (2) security. When all of the applets are compiled
into a single file, then you never have to worry about losing
some of the textures or sounds that go along with the applet.
Also, when they are all compiled into a single file, the textures
and sounds used by that applet can not be changed. This can
help to add an extra element of security to content creators who
want to make sure that users of their 3D content can change
their content and can not extract out elements of it for unautho-
rized use.

The advantages of compiling a scene into a series of files are (1)
flexibility and (2) quick downloading. When the sounds and
textures are kept as separate files, then they can be modified
and changed later. This can be useful when tuning content for
quick downloading. Second, when the resources are stored as a
series of files separate from the applet, then the applet file is
smaller. That means that the applet can be started up more
quickly because it can be started before all of the resources have
been downloaded. In this case, the sounds and textures will
stream in after the applet has downloaded and they will appear
in the applet as soon as they are downloaded and processed.
For 3D scenes with large textures, this can make a significant
difference in the amount of time it takes for the applet to start
up and begin drawing to the screen.
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The default value for this option is to NOT compile all
resources into the applet. This is because most applets are
intended to run on the web and the applets will download and
start faster if they are not compiled into a single file.

Background Options

The background options allow you to choose a background
color and image for the web page that is created. When you
select a color or image for the background, it will be displayed
in the “Preview” pane that is visible in the “Interface” tab.

Internet Explorer
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The “Mark of the Web” is a security feature that is specific to
Internet Explorer. The way that it is intended to work is that
Internet Explorer often restricts Javascript from running on
local web pages (web pages that are on your hard disk rather
than on the Internet) unless the “mark of the web” is included
on the web page. Therefore, if you have your security settings
configured to restrict pages from running Javascript, then
you’ll want to include the “mark of the web” on pages that you
export in order to preview them. When you go to post these
web pages online, however, you must remember to remove the
mark of the web, which is located on the first line of the HTML
file. If you use Firefox, then you can disregard this entire topic.



The "Textures" Tab

Pressing the "Textures" tab will display the interface shown below:

Express | Interface | ‘web Animation | Advanced | Script | About |

r Resolution

[~ Scale to nearest power of 2

[~ Make square testures

Scale all by percent (pixels): I jl
Minimumn heightfwidth (pixels): |8 ¥ Enable
Maximurn heightjwidth (pixels): |2048 ¥ Enable

r Format

¥ Prompt for missing textures

Convert unsupported Formats to: I Jpeg = l
[~ Convert all to format type: IJpeg VI

 Mipmapping
V Jpea I~ Prg I Gif

Defaults | Preview |

x|

Cancel |

This interface is used to control the format and appearance of tex-

tures that are used to paint the surfaces of objects in the exported

Hypercosm applet. These options are broken down into three main

groups:

Resolution

The "Resolution" section presents a set of options for controlling the
number of pixels in each texture map. This section presents the fol-

lowing controls:
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Scale by percent (pixels)

This option will automatically scale all of the textures used in
your 3ds Max™ scene by a constant factor. Often, the size of the
textures is the largest factor in determining the file size of an
exported scene. In order for 3D scenes to be placed on the web
in a practical manner, it is often necessary to rescale the textures
to find a good balance between file size (downloading time)
and detail. This option provides a quick and easy way to do
that without requiring you to go through your model and
rescale all of the textures individually. The default value for
this parameter is 100%.

Minimum height / width (pixels)

Often, 3D scenes have a mixture of very high resolution tex-
tures and small, low resolution textures. This option will allow
you to down sample the high resolution textures by a signifi-
cant amount without losing essential detail in the low resolu-
tion textures. By setting this value, you can ensure that textures
will not be rescaled to a resolution below a certain point. The
default value of this parameter is 8 pixels.

Maximum height / width (pixels)

This option is useful to place a maximum size on textures. This
option allows you to automatically select all of the very high
resolution textures for re-sampling while leaving the textures
below a certain size unchanged. The default value for this
parameter is 2048 pixels. Most 3D video cards are not capable
of handling textures larger than this amount, so it is always a
good idea to limit texture size to a value less than this even if
downloading speed is not a problem.



e Scale to nearest power of 2
For technical reasons, most 3D video cards require texture sizes
that are an even power of 2. That means that if your textures are
not a power of 2, then the Hypercosm Player will have to
rescale the images after they are downloaded so they can be
displayed. By rescaling the textures when the model is
exported, the Hypercosm Player can avoid this extra step.

e Make square textures
For technical reasons, most 3D video cards require textures to
be square (as well as being a resolution that is an even power of
2). If the textures are not exported as square, then the Hyper-
cosm Player will have to rescale the images after they are
downloaded so they can be displayed. Making the textures
square avoids this extra step. Making the textures square and
preserving the same amount of detail will result in larger tex-
tures which increases the downloading time. If downloading
time is a concern, then you may choose to deselect this option.

Format

The "Format" section presents a set of options for controlling the file
format used for storing texture map images. There are a variety of
different file formats that may be used for storing images and each
has their different strengths and weaknesses. The file formats that
the Hypercosm Teleporter and Player support are as follows:

JPEG (Joint Photographic Experts Group)

The JPEG format is the most popular and most generally useful
graphics format for the web. JPEG images offer good compression
and work well for images with the wide range of continuous colors
that you typically find in digital photographs. Unless you need
transparency or have textures that have just a few colors, then you
will want to use the JPEG image file format.
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GIF (Graphics Interchange Format)

The GIF image format is an older format than JPEG and is not as
good for storing digital photographs. However, the GIF fomat does
have a few unique features not offered by JPEG that make it con-
tinue to be popular for certain types of images. There are two main
cases where you would want to use the GIF format: The first is if
you require textures with transparency. The second case is if you
have images with just a few colors. For transparency, GIF images
contain a "transparency channel" or "alpha channel" that allows you
to mask out certain parts of the image as invisible. This can be very
important for creating stencil textures that have cutout areas.
Another interesting aspect of the GIF image format is that it uses a
compression technique called "run length encoding". This encoding
scheme works by detecting places where the color of the image
changes. For continuous tone images such as digital photographs,
this scheme doesn't work so well because the image color changes at
every pixel. However, if you have images with significant areas that
are the same color, then this scheme works extremely well. For
example, if you are creating texture images of text, symbols, dia-
grams, logos, or decals, then the GIF image format should be used.
For these types of images, the GIF format will result in images that
are 2 to 3 times smaller than an equivalent JPEG and look better
because the RLE encoding scheme is a "non-lossy" technique that
doesn't degrade the image because it doesn't lose any information.

PNG (Portable Network Graphics)

The PNG format was conceived of relatively recently as an alterna-
tive to the GIF format. The most important feature of the PNG for-
mat is that it allows 256 levels of transparency. The GIF format
allows you to create transparent regions in an image, but the trans-
parency in a GIF image is binary - either on or off. In a PNG image,
you can have regions that are varying levels of transparency. This is
useful for special effects such as clouds, smoke, and lighting and it is
also useful if you want to soften the edges of stenciled textures.
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The "Format" section of the Hypercosm Teleporter texture control
interface contains the following options:

e Convert unsupported formats to:
This option selects a format for textures that are part of a 3ds
Max™ model but use a format that is not supported by the
Hypercosm Player. The most common unsupported formats are
TIFF (Tagged Image File Format) and an
older format called Targa or TGA. The Hypercosm Player does
not support these formats because these formats are not opti-
mized for small file size and so they often result in images that
are too large to be practical for web distribution. By default, all
textures in unsupported formats will be converted to JPEG for-
mat.

e Convert all to format type:
This option converts all textures to a uniform format type. This
option is provided mainly for convenience and is disabled by
default.

e Prompt for missing textures
This option displays a warning whenever 3D objects are found
with links to missing textures. In order to remedy this situation,
use 3ds Max™ to locate and establish valid paths to these tex-
tures.

Mipmapping

Mipmapping is a process which allows textures to appear realistic
in 3D at a wide range of distances. Without using mipmapping, tex-
tures look correct up close, but artifacts can appear when textured
objects are placed a large distance away and the texture scale
becomes small. The mipmapping interface allows you to enabled
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mipmapping for each of the available file types (JPEG, PNG, and
GIF). The Hypercosm Teleporter interface allows you to enable or
disable mipmapping specifically for each of the supported file
types. Generally, it is a good idea to always enable mipmapping for
most textures. Sometimes, however, mipmapping introduces some
extra undesired blurring of the texture image. This can be particu-
larly troublesome for textures used as text labels because the labels
can become more difficult to read. For reasons discussed in the pre-
vious section, these types of textures are best stored using the GIF
file format. If you have a scene with a number of these types of tex-
tures that you want to remain very clear and sharp, then you can
disable mipmapping for the GIF image file type and keep mipmap-
ping enabled for all of the JPEG textures.
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The "Animation" Tab

Pressing the "Animation" tab will display the interface shown
below:

x
Express | Interface | ‘Web | Testures Advanced| Script | Abaut |

r— Contraller Sampling R ate

Frames per Sample: — [[1
p p ;III

r— Optio:

[ Force Static Scene

Static Scene Frame: ID

Defaults | Freview | Export | Cancel |

This interface is used to control how animation that is defined in 3ds
Max™ is exported. All animation is defined using 3ds Max™.
Hypercosm Teleporter does not provide a mechanism for defining
animation or creating new animation. It only controls exporting ani-
mation that has already been defined in 3ds Max™.
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Controller Sampling Rate

The Hypercosm Teleporter has two different ways of interpreting
animation controllers. For simple controllers, such as linear interpo-
lation controllers, the Hypercosm Teleporter can translate the con-
troller directly into a form that the Hypercosm Player can
understand. This is the simplest and most accurate way to translate
an animation controller. For more complex controllers, the Hyper-
cosm Teleporter may not be able to translate the meaning of the con-
troller directly and so it must sample the controller at regular
intervals. Once we have sampled the object, we can interpolate the
animation between each of the samples for a close approximation of
the original animation.

e Frames per Sample
The Hypercosm Teleporter allows you to choose how closely to
sample. A very close sampling rate will result in a very accurate
animation but the resulting applet will have a larger file size.
You should generally use as low of a sampling rate as you can
without noticeably sacrificing the quality of the animation. The
default value is 10 meaning that there will be one sample for
every ten animation frames.

Options
The "Options" box contains additional options for disabling the ani-
mation.

e Force Static Scene
This checkbox disables the animation from being exported.
Instead, a static scene will be exported. The particular static
scene that is selected from your animation sequence is con-
trolled by the options described below.
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Static Scene Frame

This numeric entry box allows you to set the frame number of
the static scene to export. You can only input a frame number
which is inside of the range of frames that you have defined
inside of 3ds Max™. If you try to input a frame number outside
of this range, it will be clamped to a valid number inside of the
allowed range. If you don't know the frame number that you
wish to export, then you can select the frame number by using
the slider below. This slider sets the frame number from the
range of frames that is defined for your 3ds Max™ scene. Drag-
ging the slider all the way to the left will set the frame number
to the beginning of your animation. Dragging the slider all the
way to the right will set the frame number to the end of your
animation.
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The "Advanced" Tab

Pressing the "Advanced" tab will display the interface shown below:

x
Express | Interface | ‘wWeb | Testures | Animation Script | Abaut |
r— Optio:

[~ Ewport Hidden Objects: W Create Configuration File

r Precizsion

Sigrificant Digits: | 5 :II

r Interface Overlay Image

Browse...

Defaults | Freview | Export | Cancel |

This interface is used to control a variety of more advanced 3ds
Max™ features and Hypercosm Teleporter. The Advanced features
are broken down into the following groups:

Options

The "Options" box contains the following:

e Export Hidden Objects
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3ds Max™ has the capability to hide objects that are present in
the scene. This is useful when you want to include objects in the
scene that may be used at a future time or in another configura-
tion of the scene. If you want the Hypercosm Teleporter to
export everything that is contained in a 3ds Max™ scene,
regardless of whether it is hidden or not, then select this option.

e Create Configuration File
When this option is enabled, a configuration file is created
when you export a model that saves your exporter settings for
that particular export. The file is saved in the same directory as
the 3ds Max file that you are exporting. This feature is useful
because the configuration file will be referenced the next time
that you restart Hypercosm Teleporter to export this same
model and therefore you won't need to reconfigure the
exporter settings. If you delete the configuration file, then the
exporter will go with the default settings instead.

Precision

Precision determines the amount of numerical accuracy that is used
to represent the positions of points that are used to define the
objects in your 3D scene. The downside of using more precision is
that it will result in a larger file that will need to be downloaded.
Generally, you want to use the lowest level of precision that still
maintains the visual quality of the scene.

 Significant Digits
The amount of precision that is used is measured in terms of
number of significant digits. Each additional significant digit
will cause the amount of precision to increase by a factor of 10,
but will also increase the amount of storage necessary. The
default value is 5, which results in a precision of 1 part in
10,000.
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Interface Overlay Image
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Hypercosm Teleporter allows you to specify an interface over-
lay image to add to the applet. Often, this interface overlay
image is used to add a logo or other branding to the applet
frame. The overlay image should be a “.PNG” file with most of
the image transparent in order to allow the applet to be seen.
The non transparent parts will be displayed on top of the 3D
scene.



The "Script" Tab

Pressing the "Script" tab will display the interface shown below:

x
Express | Interface | ‘web | Testurss | Animation | Advanced Abaut |

#REF Scene
[ Include ¥REF Declaration:

— Output
[ Create OMAR source code

— Maming

Declaration Prefix: I

Defaults Freview Export Cancel

XREF Scenes

By default, objects that are defined as XREFs will be included in
the output when you export a model using Hypercosm Tele-
porter. However, there are some circumstances where you may
want to export a model into OMAR script code in multiple
pieces, perhaps even exported by multiple people at different
times. This is possible using this option. When you select this
option, if you export the model as script code, then any objects
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that are defined as XREFs will not have their definitions
exported into script code. In order to compile these files into a
working applet, you will need to manually include OMAR
script code that defines these XREF objects. While this is a
much more cumbersome workflow process, it allows the con-
struction of complex simulations where different parts may be
modeled and exported by different people.

Output

This option allows you to export a 3ds Max model into OMAR
script code instead of a compiled applet. If you export the
model as script code, you can control almost all aspects of the
model and create complex interactive simulations. OMAR
script code can be compiled into a viewable applet using
Hypercosm Studio, a separate software product offered by
Hypercosm.

Naming
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The “Declaration Prefix” option is useful if you are exporting
several 3ds Max files into script code separately and then com-
bining the script code together using Hypercosm Studio. The
declaration prefix is used to prevent name clashes if objects in
different 3ds Max files are given the same name. When you
supply a prefix, each object exported from that file will have the
prefix appended to its name, thereby preventing name clashes
when including multiple files together that otherwise would
have differing definitions of objects with the same name.



The "About" Tab

Pressing the "About" tab will display the interface shown below:

CET— x
Express | Interface | Wweh | Textures | Animation | Advanced | Script

Hypercosm

Teleporter

Exporter for 3ds Max™
Wersion: 2,0,0.3
Sck Date: 09-08-2008: (03:01:04)

Copyright 2006 Hypereosm LLC. Www. hypercosm.com

Defaults | Freview | Export | Cancel |

This interface has two main purposes: (1) it displays some basic

information about your software and (2) it allows you to check for

updates and automatically download and install them.
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How to Get Help

3ds Max™ Online Documentation

The Hypercosm Teleporter online help system can be accessed
through 3ds Max™. There are two ways to access the Hypercosm
Teleporter Help.

e From the Windows Start Button
Just go to the Windows Start Button on the lower left of the
screen and go Programs>Hypercosm>Hypercosm Tele-
porter>Help

e From 3ds Max™ Help

In order to view the Teleporter help files from 3ds Max™, start
up 3ds Max™ and go to the “Help” menu. Under this menu,
you will see an option for >Additional Help. Clicking this will
bring up a dialog box with Hypercosm Teleporter listed. Click
on Hypercosm Teleporter to bring up the help files.

Hypercosm Web Site

If you don’t find the answers that you are looking for here or in the
3ds Max™ online documentation, you can also consult the Support
section of the Hypercosm web site located at: www.hyper-
cosm.com/support/ . If you still don’t find what you're looking for,
the Hypercosm web site will direct you to email and phone support
information.
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